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Preface

This preface introduces the Model Debugger for Fast Models User Guide.

It contains the following:
*  About this book on page 7.
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Preface
About this book

About this book

This document describes how to use the Model Debugger GUI for CADI-compliant processor models.

Using this book
This book is organized into the following chapters:

Chapter 1 Introduction
This chapter introduces Model Debugger and describes its key features.

Chapter 2 Using Model Debugger
This chapter describes how to use Model Debugger.

Chapter 3 Installation and Configuration
This chapter describes how to install and configure a standalone version of Model Debugger.
Model Debugger is automatically installed with Fast Models.

Chapter 4 Shortcuts
This chapter describes shortcuts available in Model Debugger.

Glossary

The Arm® Glossary is a list of terms used in Arm documentation, together with definitions for those
terms. The Arm Glossary does not contain terms that are industry standard unless the Arm meaning
differs from the generally accepted meaning.

See the Arm® Glossary for more information.

Typographic conventions

italic
Introduces special terminology, denotes cross-references, and citations.

bold
Highlights interface elements, such as menu names. Denotes signal names. Also used for terms
in descriptive lists, where appropriate.

monospace
Denotes text that you can enter at the keyboard, such as commands, file and program names,
and source code.

monospace

Denotes a permitted abbreviation for a command or option. You can enter the underlined text
instead of the full command or option name.

monospace italic
Denotes arguments to monospace text where the argument is to be replaced by a specific value.

monospace bold
Denotes language keywords when used outside example code.

<and>
Encloses replaceable terms for assembler syntax where they appear in code or code fragments.
For example:

MRC p15, @, <Rd>, <CRn>, <CRm>, <Opcode_2>
SMALL CAPITALS
Used in body text for a few terms that have specific technical meanings, that are defined in the

Arm® Glossary. For example, IMPLEMENTATION DEFINED, IMPLEMENTATION SPECIFIC, UNKNOWN, and
UNPREDICTABLE.

Feedback
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Preface
About this book

Feedback on this product

If you have any comments or suggestions about this product, contact your supplier and give:

* The product name.

* The product revision or version.

* An explanation with as much information as you can provide. Include symptoms and diagnostic
procedures if appropriate.

Feedback on content
If you have comments on content then send an e-mail to errata@arm.com. Give:

* The title Model Debugger for Fast Models User Guide.

¢ The number 100968 1112 00 en.

« Ifapplicable, the page number(s) to which your comments refer.
* A concise explanation of your comments.

Arm also welcomes general suggestions for additions and improvements.

Note

Arm tests the PDF only in Adobe Acrobat and Acrobat Reader, and cannot guarantee the quality of the
represented document when used with any other PDF reader.

Other information

o Arm® Developer.

*  Arm® Documentation.
o Technical Support.

o Arm® Glossary.
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Chapter 1

Introduction

Thi

s chapter introduces Model Debugger and describes its key features.

It contains the following sections:

1.1 About Model Debugger on page 1-10.
1.2 Key features on page 1-11.

1.3 Retargetable debugger on page 1-12.
1.4 Cluster debugging on page 1-13.
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1.1

About Model Debugger

1 Introduction

1.1 About Model Debugger

Model Debugger for Fast Models is a fully retargetable debugger for scalable cluster software
development. It is designed to address the requirements of SoC software developers.

Model Debugger has an easy to use GUI front end and supports:

Source-level debugging.

Complex breakpoints.

Advanced symbolic register display.
Customized window layout.

Model Debugger can connect to any Component Architecture Debug Interface (CADI) compliant model.

Model Debugger supports full cluster debugging, and multiple instances of Model Debugger stay fully
synchronized while debugging different cores running within a single system.

il Model Debugger - coretile.core.cpu0 (C:/Program Files/ARM/FastMo

|Portfolio_7.0/examples/RTSM_VE_Cortex-A15x1. dll)
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Figure 1-1 A Model Debugger session: main window with debug windows

Related information

Component Architecture Debug Interface Developer Guide v2.0
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1 Introduction
1.2 Key features

1.2 Key features

This section describes the key features of Model Debugger.

Full simulation control on C-statement and instruction levels.

C-source level display with syntax highlighting.

Integrated variable browser.

Low-level disassembly display.

Call stack and backtrace.

Complex register display with unlimited register groups and compound registers.
Memory windows with support for multiple memory spaces and bit widths.
Breakpoints on register and memory locations with complex conditions.
Advanced search capabilities.

Intuitive GUI with fully customizable window layout.

Project management to store debugging sessions including window layout, open files, and
breakpoints.

Note
Fast Models targets do not support all of these features.
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1 Introduction
1.3 Retargetable debugger

1.3 Retargetable debugger

Model Debugger supports completely retargetable debugging of any target that supports the CADI debug
interface.

All target-related information, such as the disassembly and resources like register files and flags, is
contained in the target model library. Model Debugger communicates with the target using CADI to
retrieve the static target-specific information, for example a register file. It can then determine the target
state and control execution.

Model Debugger can attach to and debug target components that are part of Fast Models systems. It can
also debug any stand-alone target model library that has a CADI interface.

Related information
Component Architecture Debug Interface Developer Guide v2.0

100968_1112_00_en Copyright © 2014-2020 Arm Limited or its affiliates. All rights 1-12
reserved.
Non-Confidential


https://developer.arm.com/documentation/100963/latest

1 Introduction
1.4 Cluster debugging

1.4 Cluster debugging

Model Debugger supports cluster debugging and can be attached to an arbitrary number of core targets in
a cluster system.

If attached to a processor model, Model Debugger automatically loads the debug information for the
respective target processor and colors all views.

Model Debugger can save the appearance for each target that is based on project files. Information that
can be saved and restored includes:

* Debugger geometry.
* Complete layout and geometry of all views.
* Breakpoints.

Related references
2.9 Model Debugger sessions on page 2-69
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Chapter 2
Using Model Debugger

This chapter describes how to use Model Debugger.

It contains the following sections:
* 2.1 Launching Model Debugger on page 2-15.

» 2.2 Connect Model Debugger to a model running on another machine on page 2-24.

* 2.3 Model Debugger application windows on page 2-25.

* 2.4 Debug views for source code and disassembly on page 2-42.
» 2.5 Debug views for registers and memory on page 2-50.

* 2.6 Debug views for pipelines on page 2-57.

» 2.7 Watch window and Expression Evaluator on page 2-62.

» 2.8 Breakpoints in Model Debugger on page 2-65.

* 2.9 Model Debugger sessions on page 2-69.

» 2.10 Preferences dialog box on page 2-70.
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2 Using Model Debugger
2.1 Launching Model Debugger

21 Launching Model Debugger
This section describes how to launch Model Debugger, and how to start models and connect to them
from it.
This section contains the following subsections:
o 2.1.1 Launching from the command line on page 2-15.
e 2.1.2 Launching from System Canvas on page 2-17.
e 2.1.3 Launching Model Debugger separately on page 2-21.
o 2.1.4 Starting simulations and connecting automatically on page 2-22.
211 Launching from the command line
To launch Model Debugger from the command line, type modeldebugger, with options and arguments.
Table 2-1 Command-line options
Short | Long option Description
--cyclelimit cycles Set a limit on the number of system cycles for a simulation in non-GUI mode.
Use the --nogui option to enable this option.
--debug-isim Start isim_system and connect Model Debugger to the simulation.
isim_system
--debug-sysc systemc Start systemc simulation and connect Model Debugger to the simulation.
-T --timelimit time Set a time limit for a simulation in non-GUI mode.
Use the --nogui option to enable this option.

-a --application filename |Load the application file filename. To target cores in cluster systems, prefix the name with

the path to the instance. For example, foo.bar.core=dhrystone.axf.

Note
For the application file to be displayed in the Model Debugger Select Targets dialog, you
must also specify the remote CADI simulation. See the -c option.

-C --parameter parameter Set one model parameter. Specify it as a path naming the instance and the parameter name
using dot separators. For example, foo.bar.inst.parameter=1000. To set multiple
parameters, use --config-file.

-C --connect simulation_id | Connect to a remote CADI simulation. simulation_id specifies the simulation to connect
to. --list-connections displays the list of available connections.

-E --enable-verbose Use verbose messages if displaying message text for message classes msgClass. Without an

msgClass argument, this option lists all classes.

-e --env-connect Connect to remote CADI simulation using the following environment variables:

«  CADI_CLIENTPORT_TCP — port number

e CADI_INSTANCEID — component instance name

e CADI_APPLICATIONFILENAME — application file name
-F --stdout-to-file FILE Print all application output to FILE instead of the StdIO pane in the Output Window.
-f --config-file filename |Use model parameters from the configuration file filename.

100968_1112_00_en
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2 Using Model Debugger
2.1 Launching Model Debugger

Table 2-1 Command-line options (continued)

Short | Long option Description
-h --help Print the available options and exit.
-i --instance Specify the instance.
-L --cadi-log Log all CADI calls into an XML logfile CADILog-nnnn.xml, where nnnn is a set of four
digits. The logfile is created in the same directory as the model.
--list-connections List possible connections to remote CADI simulations on the local machine and exit
afterwards. Each simulation has a unique simulation ID.
--list-instances List target instances.
-1 --list-params List target instances and their parameters.
-m --model filename Load the specified model.
-N --nogui Run the simulation without displaying the GUI.
-n --no-params-dialog Do not display the parameter configuration dialog at startup.
-0 --stdout-to-stdout Print all application output to stdout instead of the StdIO pane in the Output Window.
-p --project filename Load the project file filename.
-q --quiet Suppress all Model Debugger output.
--plugin Load specific trace plug-ins. The equivalent environment variable is FM_TRACE_PLUGINS.
-V --verbose Equivalent to --enable-verbose "MaxView".
-v --version Print the tool version and exit.
-X --force-reg-hex Force registers with initial integer display to be hexadecimal format instead.
-Y --layout filename Load the layout file filename.
-y --no-target-dialog Suppress the Select Target dialog box that normally appears when a model is loaded. Model
Debugger automatically connects to targets that have the executes_software flag set.
From the GUI, you can use the Other Settings check box in the Preferences dialog box to
suppress the Select Target dialog box.

String syntax

Filenames and similar strings that are specified when starting Model Debugger from the command line
must be within double quotes if there is white space in the string.

For example:

modeldebugger -a "cluster@.cpu@=my application.axf"

There is, however, no requirement to use quotes if the string has no spaces. Both of these forms are valid:

modeldebugger -a cluster@.cpu@=dhrystone.axf

modeldebugger -a "cluster®.cpu@=dhrystone.axf"

100968_1112_00_en

Copyright © 2014-2020 Arm Limited or its affiliates. All rights

reserved.
Non-Confidential




2 Using Model Debugger
2.1 Launching Model Debugger

Configuration file syntax

You can configure a model that you start from the command line with Model Debugger by including a
reference to an optional plain text configuration file. Each line of the configuration file must contain the
name of the component instance, the parameter to be modified, and its value.

Use this format:

instance.parameter=value

[T

The instance can be a hierarchical path, with each level separated by a dot “.” character. If value is a
string, additional formatting rules might apply.

You can include comment lines beginning with a # character in your configuration file. Boolean values
can be set using either true/false or 1/0, for example:

# Disable semihosting using true/false syntax
coretile.core.semihosting-enable=false

#

# Enable VFP at reset using 1/0 syntax
coretile.core.vfp-enable_at_reset=1

#

# Set the baud rate for UART @
baseboard.uart_0.baud_rate=0x4800

Related references
String syntax on page 2-16
Running Model Debugger without a GUI

Model Debugger can be run without a Graphical User Interface (GUI). This mode is triggered by the
command-line option --nogui.

To limit the duration of a simulation in non-GUI mode, specify the amount of seconds or system cycles
using the command-line options:
. --timelimit time_in_seconds

. --cyclelimit number_of_system_cycles

The --timelimit and --cyclelimit options are only available in - -nogui mode.

21.2 Launching from System Canvas

This section describes how to launch Model Debugger from System Canvas.

Procedure
1. Open the Debug Simulation dialog box:
* Click the Debug button on the toolbar.
* Select main menu > Project > Launch Model Debugger .
Results: The Debug Simulation dialog box appears.
Note
If you have loaded a model, the CADI library option and the Application field are available for use.
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2 Using Model Debugger
2.1 Launching Model Debugger

E Debug Simulation

Launch Madel Debugger and attach to targaet

(s Mone start Model Debugger alone without attaching to any target
= CADI library niot available: no project loaded
" 151k executable niot available: no project loaded

€ SwpatemC executable | not available: no project lnaded

Additional Madel Debugger command line options

Application and parameter filez for simulation

Application: |am Filez44RM4Fasttd odelPortfolio_B.0%magessbrot. axf ﬂﬂ

Pararneter file: | ﬂﬂ
| Launch System to Create File Edit File...

Meszage:

Ok Cancel

Figure 2-1 Debug Simulation dialog box
2. Click OK.
Results: Model Debugger starts.
Using the Configure Model Parameters dialog box
This section describes how to configure models.
If you had not yet loaded a model at the time that Model Debugger starts:

1. Select File > Load Model.

2. Inthe Load Model dialog box that appears, locate and select the required model, then click Open.
3. A dialog box appears:
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2 Using Model Debugger
2.1 Launching Model Debugger

.‘] Configure Model Parameters

Corfigure Parameters

cpul.CP15SDISABLE

-
[7 cpul vfpenable_at_reset

<l

cpul semihosting-enable

Parameter category | [ cpul
=] cadi_gystem_Win32-Releass-VC2008 dil
- Cmic [v cpul vip-present ﬂ =
- cpul
- ™ cpul BIGENDINIT |
-pI110_cled_0 ™ cpul VINITHI |
~term(
- [~ cpul INITRAM |
- uartlla cpul iteml_size: 10 ﬂ -
- uartlb )
- uart1a cpul.dtemi_size: (10 ﬂ
-uatt ™ cpul.UBITINIT |
[-]
[l
Bl

|

\ Category View A List View A Tree View /

Status:

[v Hexadecimal display for numeric values QK | Cancel |

Figure 2-2 Configure Model Parameters dialog box

If you had already loaded a model before Model Debugger starts, Model Debugger checks the available
components and opens a similar dialog box.

Note

The exact contents and titles of the panes might differ because they depend on the model.

The Configure Model Parameters dialog box has the following sections:
Parameter category

This pane contains a hierarchical list of the component parameters by category. To expand the
view, click the + symbol. To collapse the view, click the - symbol.

Parameter setting
The parameter values are displayed in the right-hand pane.

To toggle between hexadecimal or decimal views, use the box in the lower left corner of the

window.

Note
The name of this pane varies, depending on the model, but its purpose and usage is the same in
all cases.

To view the configuration parameters as a single list, click the List View tab. The Tree View is similar,
but shows the same parameters in a grouped hierarchy.
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2 Using Model Debugger
2.1 Launching Model Debugger

.‘] Configure Model Parameters

Corfigure Parameters

Parameter name Value | Type | Default Mode o
cmic.outputs 1 int (1 :

L1 cpub BIGENDINIT :0 bool 0 5

O cpubCP15SDIS... 0 bool 10 5

O cpulINITRAM 0 ‘bool 0 5

O cpud UBITINIT 0 bool 10 :

O cpubVINITHI 0 ‘bool 0 5

O cpul deviceace... 0 bool 0 :
cpul.dtem_size  0x10 iint 110
cpulitem0_size E3x13 Eint EI}MD

O cpubprofierena... |0 ‘baal i}
cpul}.profiler-output,: Estring ' !
cpul semihosting-A 5123456 int '[123456
cpu D.semihosting-'l'i (ezb Eint E (eab :
cpuﬂ.semihosting-c:' Estring ' E

O cpub.semihostin... ‘0 ‘boal 0 E

cpul.semihostin... i'l ibool i'l i -

' Category View A List View A Tree View

Status:
[w Hexadecimal dizplay for numeric values QK | Cancel |

Figure 2-3 Configure Model Parameters dialog box, List View tab

Set the parameters for the model and click OK to close the Configure Model Parameters dialog box.

Using the Select Targets dialog box

After closing the Configure Model Parameters dialog box, the Select Targets dialog box appears. Select
those components that can be debugged in the model.

.'] Select Targets

Select Targets to Load
Instance Mame Target Mame | SW | Type Version | Application file - click to edit {only for targets running software) |
ERM ARM_Cortex-:8  yes (Core 6.3.6 |astmodelporcfolio 7.0/ images/brot.axt v | =
[ <top level componentbiny_':l' op_ComponentE E E].. 1] |
O Memory ER}.H:Devi.ce E EPeripheralEE,}.G
Status:
Select Al Deselect All 0K | Cancel

Figure 2-4 Select Targets dialog box

1. Click the box next to the components that are to load.

2. The Application file column displays applications to load for the processors. If the correct
application is not selected, click in the field and enter the name of the source file.

3. Ifthe application name in the list is the same as the application that was already loaded, the debug
information is automatically loaded to the debugger.

4. Click OK to close the dialog box.

5. One or more instances of Model Debugger are created, depending on how many targets you selected
to load.
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If the application is loaded and the source code can be found from the debug information in the
specified file, Model Debugger displays the code in the source window.

If the debug information cannot be found because, for example, the Application file field is empty,
use the Load Application dialog box to specify the location for the source code.

Using the Load Application dialog box

If the application and source code are not loaded automatically, select File > Load Application to locate
and load the code manually.

ﬂ Load Application - Instance name: coretile.core.cpu(

Look in: |ram Files/ARM/FastModelPortfolio_7.0/mages/ | <= ] £F &
2

. phoneskin.zd
[ i o

File: name: |br01.axf
File type: | Application Files { *.elf " srec *ad ~hex "out ~in *.sym) j Cancel

[~ Load Debug Info onfy
[v Enable SMP Application Loading

Figure 2-5 Load Application dialog box

Reset the component after loading the source.
Note
The Load Application dialog box only displays if you have loaded a model from Model Debugger.

213 Launching Model Debugger separately

You can use Model Debugger to connect to and debug a remote Integrated SIMulator (ISIM) that has a
CADI interface.

Procedure

1. Launch your ISIM executable with the -S option to start a CADI server.

2. Launch Model Debugger.

3. To display the Model Debugger Connect remote dialog box, select File > Connect to Model :

+* Model Debugger - Connect remote

D MName | Description |
7000 amid. .. E C:\Program Files"ARM"\5o0CDesigner ™RYML_ARM\ARMS examplesSystems

1 connection found: Please select the simulation instance you want to connect to and press Connect.

Figure 2-6 Connect remote dialog box

4. Select the required simulation instance and click Connect.
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5. Select a target, for example the processor, and click Connect to connect to the specific component

instance in the

& select Targets

simulation.

Select Tangets to Load

Instance Name Target Mame SwW Type | Ve Select Al
SYS_ARMOIGET-S.Core ARMO2EET-5 YEE Core 3.
[ svs_:RMI926ET-5.T imer AFE_Timer Peripheral 3. Deselect Al
D SYS_ARMI1EET-S.AHE MxAHEZ Bus 3.
[] s¥s_ARM926ET-S.OMEM AHE_Meml Memory 3.
O s¥s_ARMOIZEET-S.0TCM TCOME Memory 1.
[ s¥s_rRM926ET-5. IMEM AHE_Meml Memory 3.
O s¥Ys_ARM926ET-S. ITCM TCMO Memory 1.
[ sv=s_tRM926ET-5. Irg Controller IntCtrl other 3l
< 2]
Status:
QK Cancel

Figure 2-7 Select Target dialog box

If you select more than one instance, one Model Debugger window opens for each component. Click
OK to close the dialog box.

6. If no application loads, select File > Load Application Code . Select the application image from the
Load Application dialog box and click Open.

Note

If the application loads and the debug information in the application file allows it, Model Debugger
displays the source code in the source window.

Starting simulations and connecting automatically

In Model Debugger, you can start a SystemC or Integrated SIMulator (ISIM) model simulation and then

connect to it.

Procedure
1. Select:

* File > Debug Isim System ... to display the Debug Isim System dialog box.
* File > Debug SystemC Simulation ... to display the Debug SystemC Simulation dialog box.
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.‘] Debug Isim System

Select System and Application
Selectlsim Syste |Examples\[l.l]‘ﬁ5Elhbin\Win32_\/02EIDEHREIease\RTSM_EEI_CDrTe:(—AB.e:(e jg
Application |W:\SysGen\P\fMDdeILib\T.EI\SE'\internaI&images\dhrystDne.aJd jg

Parameter and Command Line for lsim Systems

Farameter File | jg

Command Line |

Message:

0K | Cancel

Figure 2-8 Debug Isim System dialog box

2. Select a simulation and optionally an application (and parameter file for an ISIM only). If a file is
missing, an error message appears. Click OK to start the simulation and connect.
Results: The Select Targets dialog box appears.

Related tasks
2.1.3 Launching Model Debugger separately on page 2-21
Related references

2.10 Preferences dialog box on page 2-70
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2.2 Connect Model Debugger to a model running on another machine
You can connect Model Debugger to a Fast Model that is running on a different machine by using the

environment variable CADI_TARGET_MACHINE and some extra arguments when launching the model.

Procedure
1. Start the model with the arguments:

-S
Start the CADI server.

-C REMOTE_CONNECTION.CADIServer.enable_remote_cadi=1
Enable a remote client, for instance Model Debugger, to connect to the CADI server.

-C REMOTE_CONNECTION.CADIServer.listen_address=<IP_address>
Specify the network address the CADI server listens on.

-C REMOTE_CONNECTION.CADIServer.port=<port>
Specify the port the CADI server listens on.

-P
Optional parameter to print the port that the CADI server is listening on.

2. On the machine that Model Debugger will run on, set the environment variable
CADI_TARGET_MACHINE to the IP address and port number from step 1. Use the following syntax:

CADI_TARGET_MACHINE=<IP_address>:<port_number>

3. Launch Model Debugger.

Example 2-1 Connect Model Debugger and an ISIM running on separate hosts

This example connects Model Debugger running on host 2 to an ISIM running on host 1:
1. Run the following command on host 1:

./isim_system -S -p -C REMOTE_CONNECTION.CADIServer.enable_remote_cadi=1 \
-C REMOTE_CONNECTION.CADIServer.listen_address=12.34.56.78 \
-C REMOTE_CONNECTION.CADIServer.port=7000

2. Run the following command on host 2:

env CADI_TARGET_MACHINE=12.34.56.78:7000 modeldebugger
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2.3 Model Debugger application windows

The Model Debugger GUI consists of the main menu, the toolbar, and the workspace with dock
windows.

This section contains the following subsections:

o 2.3.1 Workspace on page 2-25.

e 2.3.2 Main toolbar on page 2-26.

o 2.3.3 Menu bar on page 2-29.

» 2.3.4 Dock windows on page 2-36.

o 2.3.5 Moving or copying views on page 2-36.

o 2.3.6 Saving the window layout on page 2-37.

o 2.3.7 Opening new debug views on page 2-39.

o 2.3.8 Closing windows and views on page 2-40.
o 2.3.9 Output window on page 2-40.

2.31 Workspace
The workspace can contain various view types.

* Source code.
* Disassembly.
e (Call stack.

o Thread.
* Register.
*  Memory.

* Global variables.
¢ Local variables.
e OQutput.

e Watch.

By default, the layout does not contain the thread, global variable, or watch windows.

The workspace layout can be customized by opening views, closing views, or specifying options in the
Preferences dialog box.

All views can be moved or resized. Project files enable saving and restoring the customized layout. The
files can give each processor target type, and even each target instance, a unique appearance.
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& Model Debugger - coretile.core.cpul (C:/Program Files/ARM/FastModelPortfolio_7.0/examples/RTSM_VE_Cortex-A15x1. dll)

Fle Search Cortrol Debug Layout Window Help e R
—+ pa—y
& » v o= TG B0 W w o owm [ 00 B B
Cpen Bkpts | Run Comt Stop | Step Ower Out | iStep iOver iOwt iStepn | Cycle Cyclen n-F Reset  Main
(& % Lne: | | Fle: [brotc | x ®  Address: [l w| Memspace: |Secure v | [ARM  v|x =
TLIT + o - dx v L6 7 L/; ||| Core ;l
212 . dy = dy * 16 / 17;
213 ) '0x00002328 'baffffed BLT 0x8364
;i; 1t '0x0000832C ‘eBbd81£0 POP {r4-r8,pc}
116 int main{void) *:DXDDDDEIJBD 128244010 main: G
217 * i E E EPUSH {r4,1rc} LRI ED_
18| clear_screeni(&40, 480); 0200008364 'ejallele MOV rl, #0xle0 . R3 0.
219 o |0x000083E8 ‘elal0dOa MOV £, #0x280 R4 0.
220 .+ init_led{); | i | !
221 |0x0000B3BC (ebfffE44 BL clear_screen ; 0xB80d - R3 o,
232 do [ |0x000083C0 |=bEEEEDS BL init_led ; Ox82lc ~T6 -
223 . zoom_Lloopi]; . ' . . BT 0.
222 . | whiletl); |0x000083C4 |sbEEEED B zoom_loop ; Ox834c i =
225 1 |0x000083C8 '=affEE£d B 0xB3c4 = i
=N hd '0x000083CC 00008ELO:STRHEG  r8, [r0],-10 ; ? SBZ . LI_I
.| | b |0%00008300 ‘0000205 ANDED rl0.70.pe. 28R 0 - 77| K —
|
int OxOFFFFFDB (268435416)
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-
A
log | S0 | Al [ omas] =l hd
= |11:188 [ =

A

2.3.2

Main toolbar

Figure 2-9 Default layout for Model Debugger

The main toolbar provides buttons for frequently used functions. If the functionality is not available in
the current context, the buttons are grayed out.

= &/ » v = BT O PH T o i Moo || 1000 ) )
Open Blpts Fun Comt Stop | Step Ower Out | iStep iOwver iQOut iStepn | Cycle Cyclen <-n - Reset  Main

Figure 2-10 Main toolbar
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Click to open a model library and application file. When the button is clicked:

1. If a model library is not already open, a dialog box is displayed to enable you to select a
model library to load.

Select the model library and click OK.
2. If an application is not already open, a dialog box opens to enable you to select the
application file to load into the target.

Select the application file and click OK.
3. If a model library and application are already open, a dialog box is displayed to select the
source file for the application.

Select the source file and click OK.
Note

You might use a Symmetric MultiProcessing (SMP) model with more than one processor, such
as one based on the Cortex*-A9 processor. In this case, Model Debugger only loads one image
that is run on all processors. All Model Debuggers that are attached to the SMP model load the
debug information for that image. This feature is called SMP awareness.

In certain circumstances, you can switch SMP awareness on or off by using the Model
Debugger Preferences dialog box.

Click to open the breakpoint manager.

To run the simulation until a breakpoint is hit or some exception occurs, click this button.
Encountering a simulation halt is an example of an exception that stops simulation.

Pause/Cont

Stop

Step

Over

Out

i Step

Click to pause or continue the current high-level simulation step command. An example would
be a source-level step. The button text and icon changes depending on whether the simulation is
running (Pause) or stopped (Cont).

You can interrupt high-level simulation control commands with breakpoints before completion.
These commands can be completed by clicking the Cont button.

Click to stop the execution of the model being debugged.

To execute until the simulation reaches a different source line, click to cause a source-level step.

To execute the simulation and step over any function calls, click to cause source-level steps.

To execute control command until the current function is exited, click to cause source-level
steps.

Click to advance the simulation by executing one source-level instruction.
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i Over
Click to advance the simulation by one source-level instruction without following any call
instructions.
Note
Not all model targets support this command.
i Out
Click to advance the simulation until a return instruction is executed.
Note
Not all model targets support this command.
iStep n
Click to advance the simulation by executing the number of source-level instructions that are
specified in the <-n-> control.
Cycle
Click to advance the simulation by a single cycle.
Cycle n
Click to advance the simulation by the number of cycles that are specified in the edit box. The
default is 1000 cycles.
<-n ->
Enter the number of cycles to step if the Cycle n or Back n buttons are clicked. The default is
1000 cycles.
If the i Step n button is clicked, this control indicates the number of instructions to step.
Backn
Click to step the simulation backwards by the number of cycles that are specified in the edit box.
The default is 1000 cycles.
Note
Not all model targets support this command.
Back
Click to step the simulation backwards by one cycle.
Note
Not all model targets support this command.
Reset
Click to cause a reset of the target model. The application is reloaded.
Note
For best results, Arm recommends the syncLevel of the model should be 1 or higher when using
this command.
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Main
Click to cause a reset of the target model. The application is reloaded. The model runs until the
main() function of the application source code is reached.

Note

* This command is only available if a main() function can be found in the debug information
of the application file.

* For best results, Arm recommends the syncLevel of the model should be 1 or higher when
using this command.

Related references
2.10 Preferences dialog box on page 2-70
2.3.3 Menu bar

The main menu bar provides access to most Model Debugger functions and commands.

File menu
The File menu has the following options:
Open Source ...
Opens the source code for the application.
Source File Manager ...
Displays the Source File Manager dialog box.
Load Application Code ...
Loads application code to the model.
Load Application Code (Debug info only) ...
Loads debug information only.
Load Model ...
Loads a model.
Connect to Model ...
Displays the Connect to Target dialog box to connect to a model file.
Debug Isim System ...
Displays the Debug Isim System dialog box to start and debug an isim system.
Debug SystemC Simulation ...
Displays the Debug SystemC Simulation dialog box to start and debug a SystemC simulation.
Close Model

Closes the currently open model. If Model Debugger is connected to a CADI server, the
connection is closed but the simulation continues to run.

Open Session ...

Opens a previously saved session.
Save Session

Saves the current debug session.
Save Session As

Saves the current debug session to a new location and name.
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Preferences
Displays the Preferences dialog box to enable you to modify the user preferences.
Recently Opened Models

Displays a list of the most recently opened model files. To open the file, click a list entry. By
default, the last 16 files are displayed in the list. The number of files to display can be set in the
Preferences dialog box.

To remove a file from the list, move the mouse cursor over the file name. Press the Delete key
or right click and select Remove from list from the context menu.

Recently Opened Applications

Displays a list of the most recently opened applications. To open the application, click a list
entry. By default, the last 16 applications are displayed in the list. The number of applications to
display can be set in the Preferences dialog box.

To remove an application from the list, move the mouse cursor over the application name. Press
the Delete key or right click and select Remove from list from the context menu.

Recently Opened Sessions

Displays a list of the most recently opened sessions. To open the session, click a list entry. By
default, the last 16 sessions are displayed in the list. The number of sessions to display can be
set in the Preferences dialog box.

To remove a session from the list, move the mouse cursor over the session name. Press the
Delete key or right click and select Remove from list from the context menu.

Exit

Ends Model Debugger. If you have modified files or sessions, a dialog box prompts you to save
your changes.

Search menu
The Search menu has the following options:
Find ...
Opens a dialog box that enables searching for a string in a currently active window.
Find Next
Repeats the last defined search to find the next occurrence.
Find Previous

Repeats the last defined search, but the search direction is backwards in the document.

Control menu
The Control menu has the following options:
Note

When using options that reset the model, Arm recommends the syncLevel should be 1 or higher, for best
results.

Hard Reset
This option resets the target model without reloading the application.
Reset

Click to cause a reset of the target model. The application is reloaded automatically.
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Goto Main
Cause a reset of the target model. The application is reloaded. The model runs until the main()
function of the application source code is reached.

Note

This command is only available if a function main() can be found in the debug information of
the application file.

Run

Run the simulation until a breakpoint is hit or some exception occurs. An example would be
simulation halt.

Pause/Continue Source Step

Pause or continue the current high-level simulation step command. An example would be a
source-level step.

Source Step Over

Cause a source-level step to execute until the simulation reaches a different source line.
Source Step Out

Cause source-level steps to execute control command until the current function is exited.
Instruction Step

Advance the simulation by executing one source-level instruction.

Instruction Step Over
Advance the simulation by one source-level instruction without following any call instructions.
Note

Not all model targets support this command.

Instruction Step Out
Advance the simulation until a return instruction is executed.

Note

Not all model targets support this command.

Instruction Step n

Advance the simulation by the number of instructions in the <- n -> edit box. The default is
1000 cycles.

Cycle Step
Advance the simulation by a single cycle.
Cycle Step n
Advance the simulation by the number of cycles in the edit box. The default is 1000 cycles.

Enable/Disable Step Back
Enable or disable stepping back by cycles.
Note

Not all model targets support this command.
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Back
Step the simulation backwards by one cycle.

Note
Not all model targets support this command.

Back n
Step the simulation backwards by the number of cycles in the edit box. The default is 1000

cycles.
Note
Not all model targets support this command.
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Configure cores for MP stepping ...

To enable independent execution of cores, that is, targets, use the Configure cores for MP
stepping dialog box.

a Configure cores for MP stepping @

Select caores for MP stepping

(¢ {Default - step whole simulation;

( Foreground core only - other attached targets are stopped

 Cusgtam - zingle-ztep selected targets together:

Cores

coretile. core

k. Canicel

Figure 2-11 Configure cores for MP stepping dialog box

In cluster (multiprocessor) debugging, each Model Debugger window is connected to a
particular target, and the controls in that window apply only to that target. It is the simulation
that determines how other connected targets behave when you click Stop, Step, or Run within a
window. Typical behavior is to stop and run the whole simulation.

You use the Configure cores for MP stepping dialog box to enable Model Debugger to
override the default behavior. Model Debugger can control each target to which it is connected.
It can force that target to stop executing code while the simulation is running or stepping. In that
instance, Model Debugger does not stop any target to which it is not connected. To stop during
independent stepping, connect to a target, even if you do not specifically want to view or control
that target.

Note
The Configure cores for MP stepping dialog box is only enabled if you have loaded a model.

The available MP stepping modes are as follows:
* Use Default - step whole simulation to place all execution control with the simulator. In
this mode, Model Debugger does not explicitly stop any targets.
* Foreground core only - other attached targets are stopped enables the foreground target
to run, and to stop all other targets to which it is connected.
Note

The foreground target is the target that is associated with the window that you have selected
to run.

+ Custom - single-step selected targets together enables a fixed set of targets to run, and to
stop all other targets to which Model Debugger is connected. This mode disables step and
run controls for deselected targets.
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Debug menu
The Debug menu has the following options:
Display Messages

Display debug messages.
Clear Log

Clear the log of debug messages.
Clear Model Output

Clears all output messages from the model.
Clear Output Summary

Clear the summary output messages.
Breakpoint Manager ...

Display the Breakpoint Manager dialog box.

Profiling Manager ...
Display the Profiling Manager dialog box.
Note

Fast Models does not use the profiling options.

View Profiling ...
Display the Profile Information dialog box.

Note
Fast Models does not use the profiling options.

Save Model State ...

Save the current model state. If reloaded, simulation continues from the point where the model
state was saved.

Restore Model State ...

Reload a previously saved model state.
Load Debug Info for Module

Load debug information for the module.
Set Parameters

Set parameter values for the model.
Select Targets

Select the execution target within the model.

Layout menu
The Layout menu has the following options:
Layout Control Window
To set layout options such as tiling, display this window.
Load Layout ...

Load a previously saved window layout.
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Save Layout ...

Save the current layout. Model state is not saved.
Load Recent Layout

Use a recently used window layout.
Restore Default Layout

Restore the window layout to the defaults. This option is useful if the layout has become
disorganized.

Window menu
The Window menu has the following options:
New View

Display a new debug view.

Hide
Hide an existing debug view.
Show
Display view that was most recently hidden.
Show All
Displays all previously hidden views.
Close

Close the window in focus.
Arrange Horizontally
Tile all view windows horizontally.
Arrange Vertically
Tile all view windows vertically.
Move
Move a view to the new position specified on the submenu.
Docked Views

Dock or undock the view list on the submenu.

Help menu
The Help menu has the following options:
Help ...
Opens this book in Adobe Acrobat Reader.
About ...
Displays the standard About dialog box displaying version and license information.
About Model ...

Opens the text file that contains the release notes.
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2.34 Dock windows

Model Debugger provides dock windows that can be docked inside the main workspace or floated as a
top-level window. To toggle between the docked and floating state, double-click on the dock window
handle or the title bar of the floating window.

235 Moving or copying views

Move or copy debug views within the same dock window or copied by dragging and dropping into
another dock window.

To start a drag-and-drop operation, left-click the debug view and, while holding the mouse button down,
press the F9 key.

A gray box on the left edge near the bottom of the Model Debugger window indicates the target location.
Releasing the mouse button drops the window into the gray box.
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Figure 2-12 Drag-and-drop of debug views, while moving the Memory window
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To copy the window, press Ctrl+F9. This action effectively duplicates the existing view. A gray box near
the center of the Model Debugger window indicates the location for the duplicate view for the Local
Variables window. Releasing the mouse button creates the duplicate window in the target location.

& Model Debugger - coretile.core (Cz/Program Files/ARM/PYModelLib_4.0/examples/RTSMEmulationBaseboard/Build_EBCortexA8/Win32-Debug-VC2005/cadi_system_Win32-Deb. ﬁ @|E‘

Fle Search Control Debug Layout Window Help & & ﬂldhry ﬂ i51Rd
- =
= S B A U S L R k0 0
Open | Bkpits | Run Cont  Stop | Step Over Out | iStep | Cycle Cyclen Resst  Main
@ 2 Line: | j File |dhry_1.c ﬂ X @ @ P Address: [« | Memory space: | Secure | | ARM | X =
78| 7% main program, correcponds Lo procedurss T ] |Address |Opcm_‘“3 |IZ" ‘i‘ | Core x|
77 /* Main and Froc_0 in the ada version 7 —
78 . |1 0x00007FFS 100000000 ANDER ro, o, o Reglster Value l;
7 ons_fFifty mr_1_Loc; 0x00007FFC | 00000000/ ANDEQ 0.0, 0 R0 0x0000E530
(el REG  One_Fifty Int_2_Loc; 0x00002000 '2a000000'program start_address: R1 0x0000F238
21 One_Fifty Int_3_Loc; v ) 0x00000008
= — : R x
EE REG  char ) Ch_tndex; B __scatterload ; OxBO08
83 Enumeration Enum_Loc ; R3 0x00000009
84 Str_30 Str_l_Lec: 0x00008004 |2a000600'E __rt_entry ; Ox080c R4 000000009
25 str_30 Str_2_Loc; 0x00008008 '=28f0028 __scatterload: RS 0x002E9586
=13 REG  int Fun_Tndex; scatterload rt2:
: — : -R6 0x4152474F
27 REG  int Number_of_Rune; ADR 0, _region_tabls ; 0x8038 !
a8 R7 0x00989580
= i+ Initializatiens */ 0x0000800C 28900200/ LM ro, (rlo, 11} - OxOFFFFFO0
:? - _— e ] 0x00008010 '208aa000/A00 rlo,rlo,ro o G A
. MNext_Ptr_Glob = (Rec_Pointer) malloc {sizeof {(Rec_Type 0x00008014 ‘22427001 SUB 7,710, 41 —
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a3 000008018 :20SELO0DADD ril,ril,r0 R11 0x00000001
94| Ptr_clob-»Ptr_comp = Next_Ptr_gleob; 0x0000801C '2l5a000b__scatterload null: nB13 0x000000c8
95| . Ptr_Glob-»Discr - Ident_1; cup rig, il R13 OxOFFFFFB4
g o Prr_glob-svariant.wvar_l.Enum_comp - ldenc_3; 0x00008020 $0a0005£8 BEG __rt_entry ; 0x980c ~R14 0x00008350
a7 . Ptr_slob-»variant.var_1l.Int_Comp = 40;
ag| . strcpy (Ptr_Glob->variant.var_l.Str_comp, Ox00008024 'eBbal00f LOM Tloy, {r0-z3} R15 0x00008000
o9 "DHRYSTOME PROGRAM, SOME STRING'); 0x00008028 12242014 ATR lr,__scatterload mull ; OxB0le -CPSR 0x00000103
100 « strc {str_1_Loc, "DHRYSTOME PROGRAM, 1'ST STRING"); o
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Figure 2-13 Duplicating a register view

Note
The windows might be difficult to place into the required position. To force the window to dock to a
particular location, select the window handle and right-click to display the context menu. The options
are: Dock Bottom, Dock Left, Dock Right, and Dock Top. It might take several moves to force the
window to the required location.

2.3.6 Saving the window layout

If you use different debug windows and views for different models, you can save and later reload layouts
to simplify reorganizing the views.

The Layout menu has the following entries:
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Layout Control Window

Displays the window. To change focus to the selected window, click an entry.

Layout Control Window |
=8 E-E| Central Splitter
Disassembly VWindow
o ] Left dock
- [_JRight dock
ETDp dock
i+~ B Bettom dock
- [Ta Float windows

Layout | Category

Figure 2-14 Layout Control window
Right-click to display a context menu for moving or duplicating windows.
&g & Lne | | Fie: |
Layout Control Window | “
=8 E-E| Central Splitter

DI == [isassembly Window
X Close

- BT Left dock
- [P Right dock Duplicate Window

- B Top dock BT oo o

i+~ £ Bottom dock Show %
- [ta Float windows B
Hide Dock Rig
Dock Top
Dock Bottom

Layout Category
QQ Undock imalke floating)

Figure 2-15 Layout Control context menu

Note
You can also use drag-and-drop within the Layout Control window to change the location of the
windows.
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Load Layout

Load a previously saved layout file. The window positions match the window configuration
present when the layout was saved.

B3 Load Layout

Loak in: |er|ts and Settings/mthomas/Application Daiar’AF!Mr’Max\ﬁewﬁﬂ L £ |3

o
MaxView Frame0. MaxView _layout
MaxViewFrame 1. Max\iew_layout

File name: || Open

File type: | MaxView Layout Files *. Max\iew_layout) ﬂ Cancel

Figure 2-16 Load Layout dialog box
Save Layout
Save the current window arrangement to a layout file.
Load Recent Layout

Load the last saved layout. If you have modified the current layout, a prompt asks whether to
save the current layout.

Restore Default Layout
Use the default layout.

23.7 Opening new debug views
This section describes how to open new debug views.

To open a new window:
* Select New View from the Window menu and selecting the required type of debug view.
* Click the View icon at the right of the menu bar and select a view from the list.
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[ Mew Source Window

Mew Disassembly Window
&2 MNew Call Stack Window

5l Mew Thread Window

ER MNew Register Window

Mew Memory Window

HH Mew Pipeline Overview Window
g28 Mew Pipeline Table

E6 Mew Global Variables Window
EL New Local Variables Window
[ Mew Qutput Window

52 New Watch Window
|

Figure 2-17 Icons for selecting a new debug view

2.3.8 Closing windows and views
This section describes how to close windows and views.

You can close a dock window, and all views in the window, by clicking the close button in the dock
handle or title bar. This action closes all views in the window.

To close views individually, click the specific close icon.

Close window Close view

A pdar [~| Space: | Block | X3 Addr [0000000 ~| Space: [PROC ¥ Block: |mtemaj’x

000000000 |S3DEOOD4 i‘ 000000000 |32DE0OODO4 | SBDEO0OO4 |CF7DOOOO
000000001 |SBOBROODL 000000003 |03COESZ20|83DEOOD4 |CFBRCO0ODO
000000002 |CF7DOOOO 000000006 |2C012050|2C220000|A05C0001
000000003 |0O3COESZ0 000000009 |1350FFFE| 00000002 |ZFBCO000
0x00000004 |S3DEOOD4 Ox0000000C | 03R0F0Z20|8BDEO00O4 |ZF7D0O0O0O
000000005 |CFBRCOOOO J Ox0000000F |SBDEOOO4 |4BECO0OOO| 00000002 J

Figure 2-18 Closing windows or individual debug views

2.3.9 Output window
This window displays messages from Model Debugger and from the debugging targets.

The window has the following tabs:

Log
Debugger messages, such as errors and warnings.
StdIO
Output from the target model.
All
An interleaved view for both the Log and StdIO messages.
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Related references
2.10 Preferences dialog box on page 2-70
2.3.6 Saving the window layout on page 2-37
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24 Debug views for source code and disassembly
The Source code and Disassembly views share a common window.

Each view consists of:

» A title bar with controls for selecting a target line or switching between views.
* The actual code browser for source or disassembly.
*  Columns for line number or address.

The function of the columns and title bar controls is specific to each view.

This section contains the following subsections:
o 2.4.1 Source view on page 2-42.

o 2.4.2 Disassembly view on page 2-46.

o 2.4.3 Call Stack view on page 2-48.

241 Source view
This section describes the Source view.

The Source view on the left contains two columns with a gray background that contain the line number
and bullets that represent executable code locations. The right side of the view contains your source
code.

The button with the green arrow scrolls the code browser to the location of the statement or instruction
that is to be executed next. You can find this button at the top left of the Source view window.

s
Figure 2-19 Arrow button for scrolling code

To highlight the corresponding addresses in the disassembly view, click the left-most column in the
Source view. The highlighting reveals the instructions the source statement maps to.
Note

Highlighting is only available for source lines with a bullet. The bullet indicates that the line is
executable.

To set a breakpoint on the source line, double click a bullet. A filled red circle is displayed next to the
line to indicate that a breakpoint has been set.

@ 2 Line: | j Hle:ldlx[}'.tab.c j *
157 g int main{veid) ﬂ
158 {

159 char *strings[N];

150 char buffer [N* {LOGL0_N+1]11;

161

162 + int n = 0;

183 « int ret = 1;

154 char *sorted buf;

165 UINT32 size; -
166 UINT32 count;

167

152 ' volatile UINT32 *dlx0_flag base = {volatile UINT3I2 *)DLX0_FLAG_BASE;

159 « wvolatile UINT32 *dlxl_flag _base = {volatile UINT32 *)DLX1_FLAG_BASE;

170, + volatile UINT32 *is_irg received = {volatile UINT32 *)IRQ_RECEIVED ADDR;

171 + *ig_irg received = FALSE; e
172 P | »

Figure 2-20 Source view
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The Source view title bar has controls for:

+ Selecting a target line in the source using the Line: entry box.

+ Selecting a source file that has already been loaded using the File: drop down list.
*  Opening the Debug Source Files dialog box.

Context menu for Source view
Right click in the Source view to display the context menu. The menu has the following options:
Insert Breakpoint
Insert a breakpoint at the selected location.
Enable Breakpoint
Enable the breakpoint at the selected location.
Breakpoint Properties

If a breakpoint is present on the selected instruction, selecting this option displays the
Breakpoint properties dialog box.

Run to here

Run to the selected instruction.
Word wrap

Wrap the text to fit inside the window.
File properties

Display the filename and path for the file.

Debug Source Files dialog box

The Debug Source Files dialog box lets you locate source files that are required for debugging an
application. To open the dialog box, click the icon in the upper right corner of the Source view.

Note

Pathnames appear with slash (/) characters, even on MS Windows. This fact does not affect operation.

'Iﬁ Debug Source Files

Filter: |i j Source Paths...
List of source files l Hierarchy ]
Filename | Debug pathname | Actual pathname

dOtzbc 'dxltabc C:/Program Files/...

B Open File | g Properties Find File... [~ Close dialog on file open Close

Figure 2-21 Debug Source Files dialog box

The tabs switch between two different views that list the properties for the source file:
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Filename

This column contains a list of files that the debugged application refers to. This column is not

shown in Hierarchy view.

Debug pathname

This column shows the path for the file. The pathname comes from the debug information of the
application. This path might be invalid because it refers to the original source file at compilation

time. The debug pathname can be absolute or relative to the executable.

Actual pathname

This column contains the path Model Debugger actually uses to locate the file. You can set the
path by double clicking a row or selecting a row and clicking Open File. The File Open dialog
box enables selecting the source file. After selecting the file, the file is opened in the debugger.

Click Find File to display the Find source file dialog box and navigate to the directory containing the

source.

&3l Find source file "dhry_1.c” manually

Look in: | C:/Program HIBSIARMIPVMUdeIUb_d.Dﬁmagesd

x| eE ek =

(=

brot zd

g brat.c
cpu1_linwe.zd
b dhry h

&l dhry_1c

&l dhry_ 2
dhrystone ad
Makefils
phoneskin zd
g phoneskin.c
wh.zd
Clwfis

File name: |dhw_‘| c

Fietype: | Allfiles (%)

Figure 2-22 Find Source File dialog box

Click Properties to display the File Properties dialog box for the selected file. You can also use the

Find File button in the File Properties dialog box to locate the file.

'ﬂ File Properties

Filename: dhry_1c
Debug pathname: |dhry_l1c
Actual pathname: | C:/Program Files/ARM/PVModelLib_4.0/images/dhry_1.c

0K

Cancel

Figure 2-23 Source File Properties dialog box

Model Debugger has an automatic mechanism to add replacement paths that are invoked every time you
are prompted to find a source file. If the source file is found, an automatic source path replacement is

calculated.
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This path might not always be correct. There are situations where you must manually edit source path
replacements because the automatic path is wrong for that context. You might, for example, have a
header file whose name is common between two different compilers, and Model Debugger chooses the
wrong one.

Click Source Paths... to open the Source Path Replacements dialog box. Use this dialog box to change
the path, or priority of the paths, to the source files for the application.
Note

The source path replacements are stored in the Model Debugger session file and not with user
preferences.

'lﬂ Source Path Replacements

Source path replacements:

Debug Path | Actual Path |
A EC:J"Proglam Files/ARM/PYModellib_4 0/images/

Move Up | Move Down Remowve Entry

Edit source path replacement entry

Debug path: | Apply Changes

Debug
irfo Insert as New Entry
paths:

Actual path: Browse...
QK | Cancel |

Figure 2-24 Source Path Replacement dialog box

Existing source file replacements are displayed in the top part of the Source Path Replacement dialog
box. You can remove or reorder paths by highlighting an entry and clicking one of the following buttons:

Move Up
Move the path up one position in the list.
Move Down
Move the path down one position in the list.
Remove Entry
Delete the path from the list.
Debug Path and Actual Path have the same meaning as in the Debug Source Files dialog box.

In the lower part of the Source Path Replacement dialog box, you can add new source paths or modify
existing ones. The additional features are:
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Debug info paths

Provides a tree view that simplifies navigation through the debug paths in the debug information
of the source file.

Browse

Click this button to select a path with a browser rather than typing in the actual path directly.
Apply Changes

Modify the selected entry using the entered changes.
Insert as New Entry

Adds the new path to the source path replacement list.

Searching in source files

You can search for text in the active window by using the Find dialog box. Click Find on the Search
menu to open the Find dialog box.

Find what: || ﬂ
Options
[v Caze senstive [~ Whole words only

I
Find Mext Find Previous Close
o

Figure 2-25 Find dialog box

Type the text in the box and click the Find Next or Find Previous buttons to search upwards or
downwards. Re-use previous search terms by clicking the drop-down arrow on the right of the text entry
box.

The dialog box is modeless, so you can change views without closing it. The mode is updated
automatically.
24.2 Disassembly view

The Disassembly view provides four columns for breakpoints and PC indicator, address, opcode, and
disassembly string.

If your target model has TrustZone® support, disassembly breakpoints from all worlds appear in the first
column. The filled red circles indicate a breakpoint in the world in the disassembly view, and unfilled red
circles indicate breakpoints in other worlds.

The green arrow indicates the actual position of the PC.

To display the whole disassembly in a help bubble, move the cursor over a disassembly line. This
function is useful if the complete disassembly string does not fit horizontally into the view.
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g Addess |Ox ;I Memspace: | Secure ;I I.&HM ;I 4

Addres= Opcode Digazzembly |ﬂ
(0=00007FF8 'dfdfdfcf SVCLE #lxdfdfct

‘0x00007FFC cfdfdfdf SYCET #Oxdfdfdf

O=00008000 EE]]DDDDDDE progran_=start_address:

g ; L main:
; . ‘BL __ _=catterload ; 0=x8008
@ 0=00002004 '=b00015c BL _ rt_entry : 0x857c
'0=00008008 '=28f002c__scatterload:
N | __=catterload rt2:
; ; 'ADR r0, 0=803c
‘0=0000800C '=2900=00 LOK r0, {r10, r11}
‘0=00008010 'e082a000 ADD rl0,rl0, 0
‘0=00008014 '=08bbO00 ADD rll,rll,x0
‘000008018 '=24a7001 SUB r7.rl0, #1 ~|

Figure 2-26 Disassembly view
The Disassembly view title bar has the following controls:
Address:
Enter a start address to display the code from.
Memory space:

Select Secure (TrustZone) or Normal memory space, if applicable for the processor
architecture.

Architecture

Select the disassembly mode or instruction sets for the opcodes, such as Arm or Thumb®.

Mapping source lines to the disassembly listing
To highlight in blue the corresponding addresses in the disassembly view, click the left-most column in
the source view. The highlighting indicates the disassembly instructions to which the respective source
statement maps.

Note

This action is only possible for source lines with a bullet point.

@ = ﬂ HIe:ldb-’.D.tab.c: j * (& = Addess: | ﬂ |Defauh mnj ®

]]:gg i ﬂ |Address |Opcode | Disassembly |ﬂ

157 * int mainivoid) Ox000013C8 prog_[ram_start_address: —

158 [ [ _main:

150 char *strings[N]; BC1ELE9E LW R30, 5784 (R0)

1s0 char buffer [N* {LOGLO0_N+1)1; 0x000013cc 23DEOOO4 ADODI R30, R30, #0x0004

e : 0x00001300 'AFDDFFFC sw -4(R30) , RID

162| « int n = 0;

163 » int ret = 1; 0x00001304 (03COES20 ADD R29, R30, RO

164 char *sorted_buf; 0x00001308 123DEOLLO ADDI R3O0, R30, #0x0110

165 UINT32 size; —

= OINT32 count; J 0x0000130C (AFEFOLOC sw 268(R29) , R3L

L&7 0x000013ED (AFECOLOS sw 264(R20) , R28

g o wolatile UINT32 *dlx0_flag base - o 0x000013E4 ‘BcOll608 Lw R1, S5848(R0]

169| « wolatile UINT32 *dlxl _flag base =

170] . wolatile UINT3Z *ie_irg received - 0x000013E8 (AFALOO0DC W 220({R29) , Rl

171] « *ie_irg received = FALSE; 0x000013EC 'BCO1ll6D4 LW Rl, 5844{R0)

172 !

e strings[N] = NULL; 0x0D00013F0 (AFALO0EQ sw 224(R29) , Rl

174 0x000013F4 'Bo02 1608 LW R, S584B(R0)

L3 o Resst]; hd Ox0O000L3FS 'AFAZ00EC sw 238(R20) , R2

176 i + n W ﬂ
wONANTIFC BNl 1A:4 W R1. S70R{RN1
Figure 2-27 Matching source and disassembly
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Context menu for Disassembly view

Right-click one in the Disassembly view to display the context menu. The menu has the following
options:

Insert/Remove Breakpoint

Insert/Remove a breakpoint on the selected location only in the current shown memory space
(TrustZone world). The same can be achieved with a double click in the first column.

Insert/Remove Breakpoint into /from all Program Memories

Insert /Remove a breakpoint on the selected location in all program memory spaces.
Enable/Disable Breakpoint

Enable/Disable the breakpoint at the selected location.
Breakpoint Properties

If a breakpoint is present on the selected location, selecting this option displays the Breakpoint
properties dialog box.

Show memory

Select a memory space and update the Memory view to display the memory contents at the
address specified corresponding to the instruction location.

Run to here

Step the code until the selected location is reached.

243 Call Stack view

The Call Stack view displays the call history.

To use the Call Stack view, DWAREF register mapping must be defined for the architecture and provided
in the model.

27 *i ﬂ
28| » int brot{long sx, long sy
29 {
30 « int count;
31 long px = sxX, p¥ = B¥; J
32
33 for fcount = 0; count < 23&; count++)
34 long px2, py2;
35 px2 = {px*px) >> SHIFT;
ig py2 = (py*pyl =x SHIFT;
37
ie * ff Terminmate when {(p=<®2 + py*2] = 2°2.
39 if (px2 + py2 = (4<<SHIFT)]] |
40 return count;
41 H
42 hd|
[ Giooal van | ; NIETrz
obal Varable | Type | Valu Local Varable/Parameter | Type | Value g =| Level | Address Call Stack
i..G]:ruff ch...0Ox... long 'Ox... 3 0x000084DC __rt_entry ()
i . *buff char Ox... ; long Ox... 2 0x00008200 main{) at brot.c:l53
long 'Ox... int PP 1 0x000081lc4 'render() at brot.c:1l08
long '0x... int Ox. .. * o 0x0000B020 'brot{] at brot.c:38
long 'Ox. .. long 'Ox...
long Dx...J long Dx...j J

Figure 2-28 Call Stack view

Note

The loaded application must be an ELF file that contains a .debug_frame section. No other type of
debug information is supported for the call stack view. The .debug_frame section must contain valid
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DWAREF debug information that matches the DWARF 2 or DWAREF 3 specification. The C compiler
provides this information to describe all necessary information to unwind the stack:

» The stack pointer.
* How to retrieve the previous frame pointer.
» All registers that are involved in the unwinding process.

Only the frame section can supply this information.
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2 Using Model Debugger

2.5 Debug views for registers and memory

This section describes the views that relate to register or memory contents.

This section contains the following subsections:

2.51

2.5.1 Register views on page 2-50.
2.5.2 Memory view on page 2-52.
2.5.3 Variables view on page 2-54.

Register views

This section describes the register debug views.

The Register view displays registers and their values and organizes them into multiple groups. A combo
box enables switching between the groups that the target model predefines.

ES

|
=

CT

TrapSaved

AL

Register group: GPR

..R3
...F4
...R5
...RE&
..R7
...RE
...RS

=1

Description: GPR
Mumber of registers: 32

nduingnianninge]
Ox00000000
Ox00000000
Ox00000000
Ox00000000
Ox00000000

[at=inlnlnlnlntnlinlyl

hd

Figure 2-29 Select register group

For each register, a buffered state of the register (previous value) is stored. To view the contents:
Use the context menu in the Register view and select Show Previous Values.

| GPR

Register | Walue

ML

...R0
..R1
..R2

R3
BTV

Fd
RS
RE
BT
.. R8

=i

Ox0000o0000
Ox00000000
Ox0000o0000

Ox00000000
Ox00000000

Ox00o000000
Ox00o0o0oooo0
Ox00o000000
Ox00000000
Ox0000o00o00

(aC=nlinlinlinlinlinlinlsl

A

Figure 2-30 Register view showing current and previous contents
Place the cursor over the respective register. The buffered state is updated every time the model

execution stops.
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x|
GPR Rd
Register | Value IL|
4 RFARLRIRIRIR LR IR ]u]
..R5 0x00000000
..RE Ox00000000
.R7 0x00000000
....Rk Ox00000000
.F 0x00000000
-.R1RE (General purpose register)
...r1cur: Ge(0000000
. rqprv: GeDD00DODD0D
.R13 0x00000000
=14 [nE i nininlinininlinin] j

Figure 2-31 Register view contents at cursor

Context menu for Register view

Right-click one of the registers in the Register view to display the context menu. The menu has the
following options:

Copy

Copy the contents of the selected register.
Add to Watch

Add the selected register to the Watch view.
Insert Breakpoint

Insert a breakpoint on the selected register.
Enable Breakpoint

Enable the breakpoint at the selected register.
Breakpoint Properties

If a breakpoint is present on the selected register, selecting this option displays the Breakpoint
properties dialog box.

Edit Value
Edit the contents for the selected register.
Select and show memory at nnn

Select a memory space and update the Memory view to display the memory contents at the
address that the register contents specify.

Show memory at nnn

Update the Memory view to display the memory contents at the address that the register
contents specify.

Format

Choose the number base to use to display the register contents. The options are Default
Format, Unsigned Decimal, Signed Decimal, Hexadecimal, Binary, Float, or ASCII.

Show Previous Value

Display the current value and the previous value for the selected register.
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Select All

Select the registers in the Register view.

25.2 Memory view
This section describes the memory debug view.

The Memory view displays a range of memory starting from the base address that the address field
(Addr:) specifies. Enter base addresses as decimal numbers or, by using the prefix ox, as hexadecimal
numbers. Other fields allow for selection of the address space (Space:) and physical memory block
(Block:).

2| Addr [0x00000008 ~| Space: [PROG =| Block: |intemnal -

Ox00000000 |32DE0OOO4 | SBDBO0O0O4 |CF7DO000 | 03COES20 :EJ
Ox00000004 |32DE0OOO4 | CFBCO0O00|Z2C012050 | 2Cc220000
0x=x00000008 |~05C0001|1330FFFE| 00000002 |2FBCO00D
Ox0000000C |02R0F0Z20|8BDEO0O04 |ZF7D0000 | SBDEOOD4
Ox00000010 |4BEOODOOO|00000002|83DEOOD4 |SBDBOOD4
Ox00000014 |CF7DO000|03COESZ0|83DE0N004 |CFBRCO0OOO
Ox00000018 |2C01204C|Z2C220000 | A05C0001|1330FFFE
Ox0000001C | 00000002 |2FBCO000|03A0F0Z0|8BDBO004
Ox00000020 |2F7D0000|SBDEOOC4 |4BECOOOO | 00000002
Ox00000024 |32DE0OOO4 | SBDBO0O0O4 |CF7DO000 | 03COES20
(00000028 |2C01204C|2C022048 | CC220000 | 0220F020
O0000002C |SBDBEOOO4 [2ZF7DO000 | SBDEOOD4 (4BEOOOOO _:J

Figure 2-32 Memory view

Context menu for Memory view

To display the context menu, right click one of the cells in the Memory view. The menu has these
options:

Insert Breakpoint

Insert a breakpoint on the selected memory location.
Enable Breakpoint

Enable the breakpoint at the selected memory location.
Breakpoint Properties

If a breakpoint is present on the selected memory location, selecting this option displays the
Breakpoint properties dialog box.

Edit Value
Edit the contents for the selected memory location.
Select and show memory at nnn

Select a memory space and update the Memory view to display the memory contents at the
address that the contents of the memory location specify.

Show memory at nnn

Update the Memory view to display the memory contents at the address that the contents of the
memory location specify.

Show disassembly at nnn

Update the disassembly view to display the disassembly contents at the address that the contents
of the memory location specify.
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Copy

Copy the contents of the selected memory location.
Add to Watch

Add the selected memory location to the Watch view.
Endian

Select the memory model to use to display memory contents. The options are: Default Endian,
Little Endian, and Big Endian.

Format

Choose the number base to use to display the memory contents. The options are Default
Format, Unsigned Decimal, Signed Decimal, Hexadecimal, Binary, Float, or ASCII.

Fixed column count

Display a fixed number of memory values per row. The width of the memory window
determines the number to display.

Increment column count

Increment the number of memory values to display per row.
Decrement column count

Decrement the number of memory values to display per row.
Increment current address

Increment the start address that is used for each memory row.
Decrement current address

Decrement the start address that is used for each memory row.
Increment MAU per cell

Increase the size of the word, that is, the Minimum Addressable Unit (MAU), to be displayed in
each memory cell. This option also changes the memory access size. If the chosen access size is
not supported, Model Debugger defaults to a size of a single MAU.

Decrement MAU per cell

Decrease the size of the word, meaning MAU, to be displayed in each memory cell. This option
also changes the memory access size. If the chosen access size is not supported, Model
Debugger defaults to a size of a single MAU.

Load File to Memory ...
To load a binary or ASCII file into memory, use the Load File to Memory dialog box.
Save Memory in a File ...

To save the contents of memory in a binary or ASCII file, use the Save Memory in a File dialog
box.

Memory Display Options
To enable setting column count, view format, endian mode, and MAU per cell, use the Memory
Display Options dialog box.

Load File to Memory and Store File to Memory dialog boxes

To load or store the memory contents of the target model, use these dialog boxes.
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'Iﬂ Load File to Memory

File

File: | I~

t+ Binaryfile

" Asciifile

hermaony

Mermany space |Secure

Startaddress | 0x00000000

End addrass |

¥ Hexadecimal display for numericvalues

hessage:

Load | Cancel

Figure 2-33 Load File to Memory dialog box

Enter the file name into the top field of the dialog box. You can use the button next to it to browse for the
file. When loading or storing a binary or ASCII file, select the correct button. The Memory Space and
Start Address fields are filled automatically from the memory view where you opened the dialog box.
You can change the values. Put an end address into the bottom field. When loading a file, unless you
enter a value here the maximum address of the memory is used.

If any problems occur, a message appears in the Message field.

253 Variables view
This section describes the Variables debug view.

Variables are displayed in these windows:
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Local Variables window
This window shows all local variables and parameters that are valid for the current PC value,

with their type and value.

2 Using Model Debugger

2.5 Debug views for registers and memory

* A blue letter L before the variable name indicates a local variable.
* A green letter P indicates a parameter.

[ 9 Lne: | | File: |brot.c | *®
32 * ﬂ
33 for i{count = 0; count = 256; count++)] |
EE 1 long px2. py2;

35 px2 = (px*px] = SHIFT; |
£l py2 = (py*py)] == SHIFT;
37
g J4 Terminate when {px*2 + py*2)] = 2°2.
a9 if {p=x2 + py2 > {(4=<SHIFT]] |
40 return count;
41 H
42| -
43| gy DY - {(ipx*py] == {SHIFT-1]1 + &y;
44 px = px2 - py@ + BX; -
45 B
s 4l g
X1 Local Variable/Parameter |T1,f|:-e |‘-Ialue |_|
.. Bx long 000000090 {157)
. P BY long 'OxFFFFFO4l (-703)
..L __result int ?P? i{wariable not visible for current pc)
..L count int Ox00000090 $157)
- L px long '0x0000006E 4107)
L DY long 'OxFFFFFOO4 (-556) J

Global Variables window

Figure 2-34 Local Variable view

This window shows the global variables with their types and values. A green letter G marks

them.

| Global Varable | Type | Value
-G buff ch. .. 0x00100000 -3 **
‘. *buff char 0x00 { 0) ‘Wx00°
_lung DxFFEEZE74
LB oy long ' 0x00000000 (0)
..... G dx leng '0x00003236 ({12854)
G dy long 0x0000181E {6427) J

Figure 2-35 Global Variable view

Complex values such as structs and arrays or pointers can be expanded by clicking the small cross before

the variable name.

Note

To use the variables windows, the loaded application must be an ELF file that contains .debug_info
and .debug_abbrev sections. No other type of debug information is supported for this view.

The .debug_info section must contain valid DWARF debug information that matches the DWARF 2 or
DWAREF 3 specification. The model must provide a PC register to enable locating local variables.
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For applications that have more than one compilation unit, the units are only loaded when the PC reaches
the respective context.

The loading of these compilation units can be triggered manually by selecting Load Debug Info for
Module from the Debug menu. Right-click on one of the variables windows and select Load Debug
Info for Module.

The displayed dialog box lists the compilation units that can be loaded.

Context menu for the Variable view

To display the context menu, right click one of the items in the Global or Local Variable view. The menu
has these options:

Copy

Copy the contents of the selected variable.
Add to Watch

Add the selected variable to the Watch view.
Insert Breakpoint

Insert a breakpoint on the selected variable.
Enable Breakpoint

Enable the breakpoint at the selected variable.
Breakpoint Properties

If a breakpoint is present on the selected variable, selecting this option displays the Breakpoint
properties dialog box.

Edit Value
Edit the contents of the selected variable.
Show memory

Select a memory space and update the Memory view. You can display the memory contents at
the address of the value of the variable.

Show Previous Value

Display the current value and the previous value for the selected variable.
Select All

Select the variables in the variable view.
Load Debug Info for Module

Load debug information for the module that contains the selected variable.
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2.6 Debug views for pipelines
Model Debugger provides options for viewing the pipeline.

The options are:

* The Pipeline Overview window.
* The Pipeline Table.

Pipeline views are only available if your model supports them. If the pipeline icons are gray, not orange,
then you cannot view pipeline information.

This section contains the following subsections:
e 2.6.1 Pipeline Overview window on page 2-57.
e 2.6.2 Pipeline Table window on page 2-57.

261 Pipeline Overview window
The Pipeline Overview window presents the main details of every pipeline stage.

The Pipeline Overview contains the name, program counter, opcode, and disassembly for the stages.

= StageMame | PC |Opcade |Disassembh.r |_|
IF Oxx000013C8{00000000(SYSHOF
ID 0x000013C8(00000000/8Y SMOP
EX Oxx000013C8{00000000(SYSHOF
MEM 0x000013C8(00000000/8Y SMOP
WE Oxx000013C8{00000000(SYSHOF
El

Figure 2-36 Pipeline Overview window

2.6.2 Pipeline Table window
The Pipeline Table gives a detailed view of the pipeline stages.

By default, the table shows views for all pipeline stages. Each of the detailed entries has a name and
value field.
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& P | x|®H D | x P Ex | x| #fvEM | x| @ we x| =l
PC |OxO0Q0013CE2 PC |OxOQO000L3C2 PC |OxOOQO0Ll3C2 PC |OxO0Q0012C8 PC |OxQ000L3C2
CON 3 Con 3 O 3 C O3

opc (00000000
dis|SYSNOFP

it |0=00C000000
a Ox00000000
b |(Ox00000000
d |0x00000000
i O 00000000
Fa |0x00000000
Eb (000000000
Fd |Ox00000000
ALU|{Ox00000000
LMD|0x00000000
con|0x00
mem|Jx00000000
mem| Jx00
isC|0=00

kil

opc (00000000
dis|S¥YSHNOF

it |0=00000000
a Ox00000000
b |(D=x00000000
d |(0x00000000
i Ox00000000
Fa |0x00000000
Fb |(0=x00000000
Fd |(0=x00000000
ALU(0x00000000
LMD|0=x 00000000
con|0x<00
mem|J=x00000000
mem| 0x00
isCc|0=x00

opc (00000000
dis|SYSNOF
it |(0=00000000
a Ox00000000
COx00000000
d |0x00000000
COx00000000
Ra |0x00000000
Fb (0x00000000
Fd |(Jx00000000
ALU|{0x00000000
LMD|0=00000000
con|0x00
mem|Jx00000000
mem 0x00
isC|0x00

opc (00000000
dis|SYSNOP

it |0=x00000000
a Ox00000000
b |Ox00000000
d |0x00000000
i Ox00000000
Fa |Ox00000000
Eb |0x00000000
Fd |Ox00000000
ALU|0x00000000
LMD|0x00000000
con|0x00

mem| 0x00000000
mem|Jx00
isC|0=x00

Con 3

ope (00000000
dis|S¥YSNOF

it |0=x00000000
a Ox00000000
b |(0=x000C0000
d |(0x00000000
i Q00000000
Fa |0x00000000
Fb |(0=x00000000
Fd |0=x00000000
ALU{D=x00000000
LMD|0=x00000000
con|0=<00
mem|Jx00000000
mem| 0x00
isCc|0=x00

o

Figure 2-37 Pipeline Table window

Columns and rows can be resized by grabbing the lines between them and dragging them.

The cross in the top left corner of every pipeline stage view is the starting point for drag and drop
operations. A view can be copied or moved to an empty table cell. If it is dragged beyond the boundaries
of the table, a new row or column is added in the direction of the drag.

Close view

Drag and drop handle \

Open Pipeline Stage dialog

_———m-seeee

E:
e

{HHH IF v\'|

"

Double click the first column of a view to set or remove a breakpoint on the field.

List of pipeline stages

Figure 2-38 Pipeline Table icons

Double click the second column of a view to open the field for inline edit of the value. You cannot,
however, perform an inline edit of an opcode or disassembly.

Pipeline Table context menu

Right click the empty space in the table or in an empty cell to open the context menu.
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= ) 17 ~| % % D - x4
PC (000000008 PC (000000007 I
opc A05C0001 opc| 20220000 «
dis|SEQUI R28, RZ, | dis[Lw RZ, 0(R1) 3

i} New Pipeline Stage
Resetto default
Insert Row Above
Insert Row Below
Insert Column Left
Insert Column Right
Remove Row
Remowve Column
Save Pipeline Table Layout
Load Pipeline Table Layout

Figure 2-39 Pipeline Table context menu

The context menu has the following entries:
New Pipeline Stage

Create a stage and add it to the view.
Reset to default

Use the default layout for the Pipeline Table view.
Insert Row Above/Insert Row Below

Insert a new row above or below the current cell.
Insert Column Left/Insert Column Right

Insert a new column to the left or right of the current cell.
Remove Row/Remove Column

Remove the row or column that includes the current cell.
Save Pipeline Table Layout

Save the current layout.
Load Pipeline Table Layout

Load a previously saved layout and use that configuration in the Pipeline Table view.

Pipeline Stage Properties dialog box

To open the Pipeline Stage Properties dialog box, click the orange icon to the right of the cross. You can
customize the lists in the Pipeline table with this dialog box. The combo box to the right of the orange
icon lists all pipeline stages that are available for the current model. The chosen pipeline stage is
displayed in the view underneath. To remove the view from the cell, click the X, located in the right top
corner of each list.

100968_1112_00_en Copyright © 2014-2020 Arm Limited or its affiliates. All rights 2-59
reserved.
Non-Confidential



2 Using Model Debugger
2.6 Debug views for pipelines

Pipeline Stage Properties

Pipeline stages fields to display

PC . ShowAll

Opcode

Disassembly Hide All

Visible characters in name column |3 jl

Apply | oK | Cancel |

Figure 2-40 Pipeline Stage Properties dialog box

[~ Show header

Choose the fields to be displayed in the pipeline stage list by checking the boxes or clicking the Show
All or Hide All buttons.

The size of the first column can be set in the Visible characters in the name column control.

The optional header can be switched on and off by checking the Show header check box.

Context menu for an entry in the Pipeline Table

Right click an item in the Pipeline view lists to open the context menu.

TG BB =k
Qcnnnnnng | o lre-nnnnnnnT
Eee - igd Close Pipeline Stage
dis|SEC - Copy CirbeC

—— £2 Addto Watch -
4l Insert Breakpoint
Enable Breakpoint
@ Breakpoint Properties
Edit Value
Show Memory
EFormat 3
Select All Ctrl+A
i} Pipeline Stage Properties

s22 Pipeline Table 3

Figure 2-41 Pipeline view context menu

The context menu has the following entries:
Close Pipeline Stage

Select to close the pipeline stage.
Copy

Select to copy the pipeline field. The field can be pasted into the Watch window.
Add to Watch

Select to add the pipeline field to the Watch window.
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Remove Breakpoint/Insert Breakpoint
The text that appears depends on whether the selected field already has a breakpoint:
+ If a breakpoint is present, select Remove Breakpoint to delete it.
+ Ifabreakpoint is not present, select Insert Breakpoint to add a breakpoint.

Enable Breakpoint/Disable Breakpoint
If a breakpoint is present:

+ Select Enable Breakpoint to enable it
+ Select Disable Breakpoint to retain the breakpoint, but disable it.

Breakpoint Properties
View and set the details and conditions for a particular breakpoint.
This dialog box is also available from the Breakpoint Manager dialog box.
Edit Value
Select to open the chosen field for inline edit.
Show Memory
Select to mark the memory address in the Memory Window.
Format

Select to open the submenu. This menu lets you choose the format for number display.

SNowW Memory |

| pormat [ octau Format

Select Al Ctri+A Unsigned Decimal
it Pipeline Stage Properties Signed Decimal
288 Pipeline Table > Hexadecimal

Binary
Float
ASCI

Figure 2-42 Submenu for display format
Select All
Selects all fields in the list.
Pipeline Stage Properties

To change the contents of the Pipeline Stage view, open the Pipeline Stage Properties dialog
box.

Pipeline Table
Select to display a submenu for the Pipeline Table.

Related references
2.8.4 Breakpoint Manager dialog box on page 2-67

100968_1112_00_en Copyright © 2014-2020 Arm Limited or its affiliates. All rights 2-61
reserved.
Non-Confidential



2 Using Model Debugger

2.7 Watch window and Expression Evaluator

Watch window and Expression Evaluator

The Expression Evaluator is located in the Watch window.

To display the window, select Window > New View > New Watch Window .

& MName Value |_|
- i} IF.cpcode 00000002
“I- ID.disassemblyBNEZ R28. prepare strings to sort_Ll
..ER CTRL.PC GEX Ozc00000052
~Erigger variable trigger is not walid
“leEx. pd |

~|

Figure 2-43 Watch window

There are two types of entry in the Watch window:

System variables

Entries in this group are marked with small icons to the left of their name to indicate their
origin. They can be manipulated in the Watch window in the same way as in their original view.

Items in this category include:
* Registers.

* Memory locations.

* Pipeline fields.

* Variables from source code.

Expressions for evaluation

These items do not have an associated icon because they are not duplicates of an item in a
different view. They cannot have breakpoints set and their value cannot be changed. However,

you can edit the expression itself by text in the Name column.

Double click in the left column of an existing entry to add a breakpoint for that variable.

Double click in the right column of an existing entry to edit the contents.

Double click on the last entry in the left column to enter a new expression. Press the Enter key to

evaluate the expression.

The following rules apply to the names of the resources in the target:
* Registers must be entered in the form:

$registerGroup.registerName

If the register name is unique for the whole target, the following shorthand notation can be used:

$registerName

* Pipeline stage fields must be entered in the form:

@pipelineStage.fieldName
*  Memory locations must be entered in the form:

memorySpace:address
The content of a memory location is queried with the following expression:

*memorySpace:address
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The delivered pointer can be type cast into any required type:

(typeName*)memorySpace:address

The variables of the software running on top of the target processor can be entered using an expression as
they appear in the software. They do not require a prefix or quotes. Access components of structs or
unions with the . or '->' operator according to the C syntax.

Numeric values can be entered in the following formats:

Integer values
Integer values can have binary, octal, decimal, or hexadecimal representation. The prefix
indicates the representation format:
* Binary numbers have a leading ob.
* Octal numbers a leading 0.
* Hexadecimals have a leading ox.
+ Literals with no prefix are interpreted as decimals.

Floating-point values
Floating-point values can have decimal and scientific representation.

Enter floating-point values in decimal representation (123.456) or in scientific representation
with positive or negative exponent (1.23456e2).

To form complex expressions, combine resources, variables, and literals in the target with operators. The
expression evaluator has the same operands as the C language and has the same precedence and
associativity of operators. Inside the complex expression, the resources of the target can be used if an
integer value would be sufficient in a regular C expression.

Table 2-2 Operator precedence

Precedence | Operators Associativity
1 [1->. Left to right
2 I ~+ - * & (unary) (cast) sizeof Right to left
3 * (binary) / % Left to right
4 + - (binary) Left to right
5 << >> Left to right
6 < <= > => Left to right
7 == l= Left to right
8 & (binary) Left to right
9 " Left to right
10 | Left to right
11 && Left to right
12 [ Left to right
13 2 Left to right
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This section contains the following subsection:
o 2.7.1 Context menu for Watch window on page 2-64.

Context menu for Watch window

To display the context menu, right click one of the values in the Watch window.
The menu has these options:
Paste
Insert a copied memory, register, or variable into the Watch window.
Copy
Copy an item and its value from the Watch window.
Insert Breakpoint
Insert a breakpoint on the selected watched item.
Enable Breakpoint
Enable the breakpoint at the selected watched item.
Breakpoint Properties

If a breakpoint is present on the selected watched item, selecting this option displays the
Breakpoint properties dialog box.

Edit Value
Edit the contents for the selected watched item.
Select and show memory at nnn

Select a memory space and update the Memory view to display the memory contents at the
address that the contents of the watched item specify.

Show memory at nnn

Update the Memory view to display the memory contents at the address that the contents of the
watched item specify.

Format

Choose the number base to use to display the watched item. The options are Default Format,
Unsigned Decimal, Signed Decimal, Hexadecimal, Binary, Float, or ASCII.

Increment number of bytes

Increment the number of memory addresses to display.
Decrement number of bytes

Decrement the number of memory addresses to display.
Select all

Select all of the watched items.
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2.8 Breakpoints in Model Debugger

2.8 Breakpoints in Model Debugger
This section describes how to work with breakpoints in Model Debugger.
This section contains the following subsections:
o 2.8.1 Setting breakpoints in the debug views on page 2-65.
o 2.8.2 Setting conditional breakpoints on page 2-67.
o 2.8.3 Removing and disabling breakpoints on page 2-67.
o 2.8.4 Breakpoint Manager dialog box on page 2-67.
»  2.8.5 Breakpoint Properties dialog box on page 2-67.
2.8.1 Setting breakpoints in the debug views
This section describes how to set different kinds of breakpoint in the debug views.
Source code view
The second column contains small bullets for each source line. To set a breakpoint, double click
on a bullet.
@ 2 Line: | j File: |l:|lxD.tab.c j *
157 g int main{veid) -
158 ( 4l
159 char *strings[N];
150 char buffer [N* {LOGL0_N+1]11;
151
162 + int n = 0;
183 « int ret = 1;
154 char *sorted_bwuf;
165 UINT32 Bize; .
166 UINT32 count;
157
168 . volatile UTHNT32 *dlx0_flag base = {volatile UINT32 *)DLX0_FLAG_EBARSE;
159 « wvolatile UINT32 *dlxl_flag _base = {volatile UINT32 *)DLX1_FLAG_BASE;
170 « wvolatile UINT32 *ie_irg received = {volatile UINT32 *]IRQ_RECEIVED ADDOR;
171 + *ig_irg received = FALSE; e
172 P | | »
Figure 2-44 Source view breakpoint
Disassembly view
To set a breakpoint on a line, double click on any column.
[ 9 Addess: | ﬂ | Default mode j x
| Address | Opcode | Dizassembhy |ﬂ
0x00001420 0CO00L34 JAL _init_timer —
Ox00001424 54000000 NOF
® 000001428 main_Ll:
BCO11920 Lw Rl, 6432 (R0O)
Ox0000142C ' 0OCO001BC JAL _start_timer
000001430 54000000 MNOF
0x00001434 OFFFFECC JAL _wait_for_irg
0x00001438 54000000 NOF
Ox0000143C OFFFFCTO JAL _reset_irg received
000001440 54000000 MNOF
Ox00001444 8c01l16R8 LW R1l, 5200(R0] ﬂ
Figure 2-45 Disassembly view breakpoint
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2.8 Breakpoints in Model Debugger

Register view
To set breakpoints, double click on the first column, the register name column.

x|
[GPR B
Register | Value -
...R0O O=00aooooo

B8 000000000
. R2 Qx=00000oon0
-.R3 Ox00000000

.4 Qx=00000oon0
...R5 Ox00000000
..RE Qx=00000oon0
-R7 Ox00000000

A

Figure 2-46 Register view breakpoint

Memory view

To set breakpoints, select Insert Breakpoint from the context menu. It is not possible to set a
memory breakpoint by double clicking on an address.

Local variables view

It is not possible to set these breakpoints.

Global variables view

It is not possible to set these breakpoints.

Call stack view
To set breakpoints, double click on items in the first column.
Note

To use this view, the architecture must have a definition of the DWAREF register mapping and

the model must have DWAREF register mapping too. The loaded application must be an ELF file
that contains a .debug_frame section.

Pipeline Table
To set breakpoints, double click on the name in the first column.

Pipeline Tahle =]

+{HH IF - | x| {0 - | x| & EX - | x| & mEM - | x| & we v|x| -]

PC |0x00001634
Cony 3
@ d:FBECOO0OO

sw O{R239]
it |Ox00000000
a Ox00000000
b |0x00000000
d |0=x00000000

i O=00000000

R2!

PC (0=x00001&30
Com 3
opc|230DEOOO4
dis|ADDI E30,
it |[0=x00000002
a (0x00001B848
b |0=x000000a0o0
d |0=x0000000o0
i |[Ox0O0C00004

R3O0,

PC (0=x00001le62C
CoOn 3

opec|03C0OES20
dis(pDD R2I9,
it |[0=x00000001
a Ox00001844
b |0=x000000a0o0
d |0=x00000000
i Ox00000000

R3O,

1

PC (0=x00001628
CoOn 3

opc |AFODOFFFC
dis|swW -4{R30)
it |O=xOO0000004
a Ox00001840
b |0x00000000
d |0=x0000172C
i OxFFFFFFFC

PC (0=x00001624
Com 3
opc|00000000
dis|S¥YSHNOP

it |0x00000000
a Ox00000000
b |0x00000000
d |0=x00000000
i O=00000000

o

Figure 2-47 Pipeline table breakpoint
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2.8 Breakpoints in Model Debugger

Watch view

If you copy an item from another view into the Watch view, you can set breakpoints in either the
original view or the Watch view.

2.8.2 Setting conditional breakpoints
Some breakpoint objects support conditional breakpoints.

To create a conditional breakpoint:

Procedure

1. Set an unconditional breakpoint.

2. Set the conditions for the breakpoint with the Breakpoint Properties dialog box.
Related references

2.8.5 Breakpoint Properties dialog box on page 2-67
2.8.3 Removing and disabling breakpoints
This section describes how to inactivate breakpoints.

You can quickly remove a breakpoint by double clicking on it. To inactivate a breakpoint without
removing it, disable the breakpoint by right-clicking on the breakpoint and selecting Disable breakpoint
in the resulting context menu. A disabled breakpoint is shown as a gray, rather than red, circle symbol.
Other breakpoint dialog boxes and menus also permit you to configure your breakpoints.

284 Breakpoint Manager dialog box
Control and maintain all breakpoints through the Breakpoint Manager.

This dialog box lists all breakpoints and provides the breakpoint target location, condition, and target
details.

Breakpoints that are hit are highlighted in the breakpoint list with an orange background. The breakpoint
is also highlighted in the original view for the item.

In the breakpoint list, select an item to:

* Enable, disable, or remove breakpoints.

* Locate the breakpoint target location in the respective debug view.
* Modify breakpoint conditions using the Properties button.

¥ ModelDebugger - Breakpoint Manager

D Tvpe Location Trigger Type Condition Memony Space Dietails | Remove
&0 dhry_1.c:207 - address: (00008414

® 2 dhry_2c:76 - address: Be00003DFS Enable
[ 3] dhry_1.c;146 - address: a000082B0 )
&4 00003018 - Secure st
& 10 k00008043 modify - space: Secure, size: 1

Locate

Properties

Select Al Close

Figure 2-48 Breakpoint Manager dialog box

diadad

28.5 Breakpoint Properties dialog box

Open the Breakpoint Properties dialog box by right clicking on a breakpoint and then selecting
Properties from the resulting context menu, or with the Breakpoint Manager.

Select the breakpoint criteria with the Breakpoint Properties dialog box:
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2.8 Breakpoints in Model Debugger

Ignore count

Enter the number of occurrences to ignore before triggering the breakpoint. Enter 0 to trigger a
breakpoint for every occurrence.

Enable breakpoint

To enable the breakpoint, check this box. If unchecked, the breakpoint location and type is
stored, but occurrences do not trigger a breakpoint.

Continue Execution after hit

To enable the continuation of execution after breakpoint hit, check this box. If checked the
execution of the debugged application does not stop when the breakpoint is being hit.

Resource

Select the condition that results in a breakpoint being triggered. Conditional breakpoints are not
supported for some types of breakpoint object.

Value
If the Resource type is not breaks unconditional, select the comparison value that is to trigger
the breakpoint.

Trigger Type

Select whether a Read, Write, or Modify operation triggers the breakpoint. These check boxes
are not enabled for some types of breakpoint object.

Hexadecimal value display

Check to display the contents of the Value field in hexadecimal format. If unchecked, decimal
format is used.

h Breakpoint Properties

Type: Source
Location: brot.c:220
Details: address: 0x000083C0

lgnare count: E
I Enable breakpoint

[~ Continue Execution after hit

Breakpoint Condition

Eesource | hreaks unconditional J

alue: |

[comparison is always signed)

Trigger Type
[~ Bead [ Whirite ™ Modify

I Hexadecimal value display

Ok | Cancel

Figure 2-49 Breakpoint Properties dialog box
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2.9 Model Debugger sessions

29 Model Debugger sessions

Model Debugger session files enable saving and restoring debugging sessions and provide a convenient
way to specify the session parameters.

Session files have the extension *.mvs.

Note

The session files are only available for directly loaded models. They cannot be used for connections to
Model Shell or SystemC simulations.

The information that can be saved and restored includes:
* Debugger main window geometry.

* Layout of all debug views.

» Target model being loaded.

* Application file.

* Breakpoints.

Session files also enable configuring the individual layout of debugger windows for cluster systems. You
could, for example, then use the project with SoC Designer.

To save a session, select Save Session, or Save Session As, from the File menu.

To load a session and restore the original model connection and window layout, select Load Session
from the File menu.
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2.10 Preferences dialog box

210 Preferences dialog box
Configure the behavior of Model Debugger with the Preferences dialog box.

h Preferences

Appearance Yerbose Messages Settings

External Tools
Enable meszages

Fants _
" MNone (¢ Selective " al
Suppreszed Messages
DthelS sttings Meszage 1D Description
O PClrfo PC walue, source file and line info, disazsenmbly.

O DwaRFReg  Yerbose DWwARF register mapping and memory space info
O DwaRFLoader Yerbose DWwWARF debug info loading

O Linelnfo Dump ling info after loading application

O aspploader Yerboze loader meszages [model loading the application)
Debugloader  “erbose loader messages [debugger loading the application)
[ ModelDebugger General Model Debugger verboze messages

Apply | (1] | Cancel

Figure 2-50 Preferences dialog box

To display the options for that category, select an entry in the list on the left side of the dialog box:

Appearance
Each option has a checkbox:
» Show tool tips enables display of pop-up help for a control.
+ Display toolbar text labels displays text below the icon.
*  Word wrap in source window wraps long lines to fit the window.
* Show splash screen on startup displays the information screen.
* Reload recent layout on startup keeps your last used layout.

Use the controls in the Recent files and directories to control how many previously used files
and directories are displayed.

External Tools

The use operating system file associations checkbox is only available on Windows, and is
selected by default. This setting inactivates the external tool edit fields and buttons. To activate
these fields, clear the checkbox.

Note
The default external tools are different on Linux.

Configure the display of the documentation with these settings. Access the documentation

through:
* The Help menu item. You access the PDFs for the Model Debugger and Fast Models this
way.

* The documentation_file property in a component property listing. This property might point
to a PDF file, a text file, an HTML file, or http:// link.

You can change the default external tools. Click the folder icon to open a browser, or use the
drop-down list to choose a previously selected executable.
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2.10 Preferences dialog box

Fonts

You can specify the fonts for each of the windows.

To control the fonts with the $DISPLAY variable, check Fonts depend on $DISPLAY variable.
Suppressed Messages

Lists the suppressed messages and enables you to specify an action for each message.
Verbose Messages

Turn on or off verbose message setting for the message IDs. To turn on or off individual
messages, click Selective.

Other settings

Each option has a checkbox:

* Load all Compilation Units at Startup: load all required files.

+ Show Parameter Dialog at Startup: display the dialog box to configure model parameters.

+ Show Target Dialog at Startup: display dialog that normally appears when a model is
loaded. If unchecked, Model Debugger automatically connects to targets that have the
executes_software flag set.

* Enable SMP Application Loading: have Model Debugger load the application once into
memory and load only debug information for all processors. The PC is set to the value of the
first processor in all processors.

After displaying the dialog box and modifying preferences:

* Click Apply to apply the settings and keep the dialog box open.

* Click OK to apply the settings and close the dialog box.

* Click Close to close the dialog box. Unapplied settings changes are lost.
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Chapter 3
Installation and Configuration

This chapter describes how to install and configure a standalone version of Model Debugger. Model
Debugger is automatically installed with Fast Models.

It contains the following sections:

e 3.1 Linux installation procedure on page 3-73.
e 3.2 Windows installation procedure on page 3-75.
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3 Installation and Configuration
3.1 Linux installation procedure

31 Linux installation procedure
This section describes the procedure for installing Model Debugger on Linux.

This section contains the following subsections:

*  3.1.1 Linux software requirements on page 3-73.

* 3.1.2 Linux installation on page 3-73.

*  3.1.3 Linux environment configuration scripts on page 3-73.

311 Linux software requirements
This section describes the software requirements for using Model Debugger on Linux.

Operating system
* Red Hat Enterprise Linux 6 or 7.
+ Ubuntu 16.04 LTS or 18.04 LTS.

PDF reader
Adobe does not support Adobe Reader on Linux. Arm recommends system provided
equivalents, such as Evince, instead.

License management utilities
The latest version of the FlexNet software that is available for download from License Server
Management Software.

3.1.2 Linux installation
This section describes how to install Model Debugger.
Unpack the archive and run the setup program:
gunzip ModelDebugger version.tgz

tar -xvf ModelDebugger_version.tar
cd ModelDebugger_version./setup.bin

In the sequence of commands, version is the version of Model Debugger you are installing.

The installer prompts you for the target installation directory and creates the following subdirectories:

bin
Executables.
doc
Documentation.
etc
Model Debugger setup scripts.
1lib
Libraries and tool-specific files.
313 Linux environment configuration scripts

Model Debugger provides setup scripts in the etc directory. The appropriate setup script must be
executed to configure your environment for Model Debugger.

* For Bourne and related shells, use:

. ilnstallation_directory/etc/setup.sh
e For C and related shells, use:

source installation_directory/etc/setup.csh

100968_1112_00_en Copyright © 2014-2020 Arm Limited or its affiliates. All rights 3-73
reserved.
Non-Confidential


https://developer.arm.com/tools-and-software/software-development-tools/license-management/downloads
https://developer.arm.com/tools-and-software/software-development-tools/license-management/downloads

3 Installation and Configuration
3.1 Linux installation procedure

You might find it more convenient to add a reference to the Model Debugger configuration script to your
usual startup script.

The setup script sets the following environment variables:

Table 3-1 Environment variables

Variable Description
$PATH The PATH environment variable is updated to include installation_directory/bin.
$MAXVIEW_HOME Set to the Model Debugger installation directory. Model Debugger was previously named Max View.

$ARMLMD_LICENSE_FILE | Set to the location of the license file or license server (using port@host syntax) for Model Debugger.
See License Management for more information. If necessary, you can change this environment variable
after installation by editing the setup. [c]sh script.
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3 Installation and Configuration
3.2 Windows installation procedure

3.2 Windows installation procedure

This section describes the procedure for installing Model Debugger on Windows.

This section contains the following subsections:

3.2.1 Windows software requirements on page 3-75.
3.2.2 Windows installation on page 3-75.

3.21 Windows software requirements

This section describes the software requirements for using Model Debugger on Windows.

Operating system

Microsoft Windows 10 64-bit.

PDF reader

Adobe Acrobat Reader.

License management utilities

The latest version of the FlexNet software that is available for download from License Server
Management Software.

3.2.2 Windows installation

This section describes how to install Model Debugger.

Procedure

1.

Open the distribution archive ModelDebugger_version.zip and extract the complete contents into a
temporary directory. version is the version of Model Debugger you are installing.

To start the installer, run the Setup. exe program in the temporary directory.

3. When prompted by the installer, specify the target directory for the installation or accept the default

directory.
The installer creates subdirectories in the specified installation directory.
bin

Executables.

doc
Documentation.

Note

The installer configures the environment variables for the user who installed the tools. Other users
might need to use Model Debugger on the same computer. Either copy the value of the
%MAXVIEW_HOME% environment variable to the System variables, or have them define the environment
variable themselves in Control Panel. Both operations need administrator privileges.
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Chapter 4
Shortcuts

This chapter describes shortcuts available in Model Debugger.

It contains the following section:
* 4.1 Keyboard shortcuts on page 4-77.
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4 Shortcuts
4.1 Keyboard shortcuts

4.1 Keyboard shortcuts
This section describes the keyboard shortcuts.
Table 4-1 Keyboard shortcuts
Modifier | Key | Function
- Esc | Close the current dialog.
- F1 | Help.
- F3 | Find next.
Shift F3 | Find previous.
- F5 | Run target.
Shift F5 | Stop target.
- F10 | Source-level step over.
Ctrl F10 | Source-level step out. This action leaves the current function.
- F11 | Source-level step into.
Shift F11 | Instruction-level step.
Shift F10 | Instruction-level step over.
Ctrl+Shift | F11 | Instruction-level step out.
Ctrl F11 | Cycle step.
Ctrl+Shift | F11 | Cycle step N.
Ctrl B Open the breakpoint manager.
Ctrl+Shift | C Connect to model.
Ctrl+Shift | D Load debug information from application code.
Ctrl F Search (find) operation.
Ctrl+Shift | L Load model library.
Ctrl+Shift [ M | Go to function main().
Ctrl ¢ Multi-functional open. If no target is loaded, a dialog is displayed to select the model library and application code. If
a target is loaded, the source file is opened.
Ctrl+Shift | O Load application code.
Ctrl P Open the Model Parameter dialog.
Ctrl+Shift | P Pause or continue source step.
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4 Shortcuts
4.1 Keyboard shortcuts

Table 4-1 Keyboard shortcuts (continued)

Modifier | Key | Function

Ctrl Q Close Model Debugger.

Ctrl R Reset target only.

Ctrl+Shift | R Reset target and reload application.
Ctrl S Save the current session.

Ctrl T Select target.

Ctrl U User preferences dialog.

Ctrl W | Close model.
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